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DECLARATION OF CONFORMITY 

 

A printed version of the Declaration of Conformity has been provided 
separately within the original shipment of goods. However, you can find a 
copy of the latest version at 

http://www.mtl-inst.com/certificates 

 

 

GENERAL SAFETY INFORMATION 
 
The following methods are used in this manual to alert the user to important 
information:- 
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1 Annunciator Model Code Definition 
Code Description  

 Model No 
SMA SmartAlarm 

  
 Alarm Ways 

08 08 Way 
16 16 Way 
24 24 Way 

  
 Individual Channel Repeat Relays 

X No Individual Channel Repeat Relays Fitted 
R Individual Channel Repeat Relay Fitted  
  
 Primary Supply – Internal PSU-1 

A Universal Input 85-264VAC & 88-300VDC 
 OR as an option which must be specified at time of order 

D 19-72VDC (Must Be Specified At Time Of Order) 
  
 Aux Supply – Internal PSU-2  (Future) 

X Not Fitted 
A Universal Input 85-264VAC or 88-300VDC 
 OR as an option which must be specified at time of order 

D 19-72VDC (Must Be Specified At Time Of Order) 
  
 Field Contact (Signal Supply) Internal / External 

A Internally  Generated 24VDC   /  Ext Supplied 24VDC & 125VAC/DC 
B Internally  Generated 24VDC   /  Ext Supplied 48VDC & 250VACVDC  
  
 LED Colour 

R Red 
Y Yellow 
G Green 
B Blue 
W White 
I Intermixed 
  
 Communications 

X Not Fitted 
S RS485 Serial Communications Fitted 
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Code Description 

 Tropicalisation 
X Not Fitted 
C Tropicalised 
  
 IP Rating 

4 IP40 Rated 
5 Optional IP54  
  
 Special Options 

X Not Fitted 
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2 - INTRODUCTION 

2.1 General 
The SmartAlarm is a panel mounting alarm annunciator used to inform the 
operator that a process has gone beyond set limits using visual and audible 
alarms.  
 
 

 
 
The system comprises the following key elements 
 

 1 x Face plate. 
 

 Laser printed film legend sheet/sheets. 
 

 1 x DIN sized flush mounting cabinet.  
 

 1 x Rear mounting motherboard complete with customer terminals. 
 

 1 x Common Services Card.  
 

 ** x 8 Channel alarm card / cards  (** qty depends on annunciator 
size). 

Available Versions 
8, 16 or 24 Way versions are available using industry standard DIN Size 
enclosures.  



INM P825 Rev 4  4 | P a g e  

Card Locations 
Four screws are provided on the face plate of the annunciator to allow access 
to the internal cards. 
 

 
Once the Faceplate has been removed access is available to the two types of 
card used within the SmartAlarm. 
 

 



INM P825 Rev 4  5 | P a g e  

2.1.1 PSU/Common Services Card 
 

 The PSU/Common Services Card is located in the right hand card slot 
of the enclosure, (Position 0), when viewed from the front. 

 
 As PSU/Common Service cards can be powered from 85-263VAC 

50/60 Hz  or 88 to 300VDC for safety reasons please ensure the 
supply is fully isolated before removing the associated card.  
 

 Single and Dual redundant power supply options are available 
providing secure power to the panel. For further information please see 
pages 17 and 18 
 

2.1.2 Alarm Cards (8 Channel) 
 

 Alarm cards are located to the left of the PSU/Common Service card.  
 

 On 16 and 24 way versions multiple alarm cards are used.  
 

 The alarm cards are interchangeable however as the associated 
configuration settings are stored on the individual cards if a card is 
placed in the incorrect slot the setting may not match the monitored 
process.  
 

 The PSU/Common Services card and Alarm card are polarised to 
prevent insertion into the incorrect card slot. 
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2.1.3 Pluggable LED’s 
Each channel is illuminated by a pluggable LED located on the front of each 8 
channel alarm card.  
 
The LED assembly is held in place by 2 pins and the assembly can be 
removed by pulling gently towards you. 
 

 
 
LED assemblies are available in the following colours:-  
 

 White .........(WT). 
 

 Red ............(RD). 
 

 Yellow ........(YW). 
 

 Green .........(GN). 
 

 Blue ............(BL). 
 

 Intermixed …….(I). (Specify colour required per channel). 
  

 



INM P825 Rev 4  7 | P a g e  

 

 

2.1.4 Input Isolation 
All signal inputs are optically isolated for use in harsh electrical environments. 

2.1.5 Bi-Polar Inputs 
125v and 250v signal inputs are bi-polar and therefore capable of accepting 
AC or DC voltages. 24 V and 48V are DC input only 

2.1.6 Standard Input Version 
The standard version uses a fully isolated +24VDC supply as a signal voltage, 
(fused at 160mA), which can be fed via a normally open (N/O) or normally 
closed (N/C) field contact to trigger each alarm as required. 

2.1.7 Optional Powered Input Versions 
As an alternative Customer powered Inputs can be used:- 
 

 Option A = 24VDC & 125VAC/DC or  
 Option B = 48VDC & 250VAC/DC.  

 
The signal supply voltage level must be specified at the time of order to 
ensure the correct type alarm card is supplied. 

2.1.8 Integral Pushbuttons 
Four Integral tactile pushbuttons are provided as standard designated as 
Test, Mute, Ack, (Acknowledge), and Reset.  

2.1.9 Customer Terminals 
Industry standard rising clamp terminals capable of accepting up to 2.5mm2 
cable are provided for customer use on the rear of the annunciator and each 
terminal is held in place by retaining screws located at the top and bottom of 
each terminal block for additional security. 

 
Typical Annunciator Rear View 
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2.1.10 Terminals For Use With External Pushbutton Inputs 
Five additional optically coupled inputs , PB1 to PB5, are available on the rear 
of the annunciator for use with external pushbuttons, group inhibit or a sleep 
mode switch as required.  
 
The common return for the remote inputs is PCom  
 
 

 
 
Please note: VAUX +24V can be used for external pushbuttons, or any 
nominal 24V terminal on the rear panel.  
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2.1.11 Internal Audible Alarm 
An integrally mounted 2.4Khz speaker  is located on the common services 
card. 
 
 
To adjust to volume use the slider in the SmartAlarm configurator as shown 
below. 
 

 
 
 

2.1.12 HNA & HNB Horn Relays 
Common Relay – HNA & HNB are used as Horn Relays and the following 
options are software selectable:- 
 

 Any channel within the annunciator can be set to operate either relay 
as required.  
 

 The relay coil state can be set to Normally Energised or Normally De-
Energised. 
 

 The relay can be disabled to prevent it operating on System Test. 
 

 The relay can be disabled to prevent it operating during Sleep Mode. 
 

 Relay mode is set to horn as default but can be modified to other 
modes using the configuration software.     
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2.1.13 GPA & GPB Common Alarm Group Relays 
Common Relay – GPA & GPB are used as Group Relays and the following 
options are software selectable:- 
 

 Any channel within the annunciator can be set to a common alarm 
group. 
 

 The group function can be set to “alarm” which keeps the signal active 
until the alarm has been cleared. 
 

 Any “alarm” group within the annunciator can be linked to either relay 
as required. 
 

 A reflash function can be selected per group which allows the contacts 
to revert to normal and re-alarm each time a new alarm occurs within 
the same group. The reflash pulse duration can be set between 1mS 
and 65,000mS. 
 

 The relay state can be set to Normally Open or Normally Closed. 
 

 The relay can be disabled to prevent it operating on System Test. 
 

 The relay can be disabled to prevent it operating during Sleep Mode. 
 

 Relay mode is set to group as default but can be modified to other 
modes using the configuration software. 

    



INM P825 Rev 4  11 | P a g e  

2.1.14 WD Watchdog Relay 
A Watchdog Relay is available as standard to provide a signal to a 3rd party 
device to indicate a fault has been detected within the annunciator. The 
following options can be configured in software. 
 

 All faults. 
 Field contact fault. 
 System fault. 
 Comm’s fault. 
 Card fault. 
 LED fault. 
 Power fault. 

 

 
Typical Volt Free Relay Contact Outputs 
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2.1.15 Watchdog Monitoring LED’s 
As alarm annunciators are used in safety critical applications it is important 
that the functions of the annunciator are monitored and the SmartAlarm is 
equipped with an extensive self-diagnostic facility including two green status 
LED’s, in standard mode they provide dynamic monitoring of the logic supply, 
field contact supply, and system status. In diagnostic / program mode the 
LED’s allow real time contact status monitoring, manual input type 
programming and communications Tx & Rx monitoring.  
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2.1.16 Diagnostic / Program mode - Dynamic Contact Status 
The internal pushbuttons can be used to view the dynamic state of all signal 
inputs by pressing and holding the internal Test pushbutton for 10 seconds. 
 

 
 
LED-1, located above the test pushbutton, slow flashes to indicate the 
Annunciator is in monitor mode. 
 
Whilst in this mode the individual channel LED provides the dynamic status of 
the associated field contacts.  
 

 If the LED is ON the field contact is CLOSED. 
 

 If the LED is OFF the field contact is OPEN.  
 
This is a quick method of verifying the dynamic state of the field contact and is 
typically used during commissioning or fault finding.  
 
The contact monitoring function times out after 1 minute and the unit 
automatically returns to the normal run mode and LED-1 reverts to steady 
ON. 
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2.1.17 Diagnostic / Program mode - Manually changing the input type 
The internal pushbuttons can be used to change the input state for each 
channel from normally open (N/O) to normally closed (N/C) by pressing and 
holding the internal Test pushbutton for 10 seconds. 
  

 
LED-1, located above the test pushbutton, slow flashes to indicate the 
Annunciator is in the monitor mode. 
 
Press the Mute pushbutton once and note LED-2 and Channel-1 LED slow 
flash to indicate that you are now able to invert the state of Channel-1 as 
required. 
 
Pressing the Ack. pushbutton navigates to the next channel in sequence and 
once the last channel has been configured the cycle repeats. 
 
Pressing the Reset pushbutton toggles between N/O or N/C 
 
Note: As you navigate away from each channel . 
 

 If the LED remains ON the input is set to normally closed . 
 

 If the LED is OFF the input is set to normally open . 
 
The “input state function” times out and the unit automatically returns to the 
normal run mode after 1 minute and LED-1 reverts to steady ON. 
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2.1.18 Diagnostic / Program mode - Communication Monitoring 
The internal pushbuttons can be used to monitor communication activity 
between the SmartAlarm and 3rd Party devices by pressing and holding the 
internal Test pushbutton for 10 seconds. 
 

 
LED-1, located above the test pushbutton, slow flashes to indicate the 
Annunciator is in monitor mode. 
 
Press the Mute pushbutton twice and note LED-1 and LED-2 go OFF and 
then act as Rx & Tx for communication between devices. 
 
The communication monitoring function times out and the unit automatically 
returns to the normal run mode after 1 minute and LED-1 reverts to steady 
ON. 
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2.1.19 Programmable Features 
The SmartAlarm is equipped with a host of customer selectable features 
which can be accessed via a USB Mini-B programming port located behind a 
rubber bung on the face of the annunciator.  
 

 
Once connected to a PC running the Eaton supplied configuration software 
the user can enable or disable pre-defined functions as required.  
 
Selection of features is on a per channel basis with no special tools or 
programming knowledge required.  
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2.1.20 Film Legends 
Laser printed alarm legends are used within the SmartAlarm allowing the 
Customer to easily change the legends on site as required.  
 
Film legends can be created in a style, size, font and language using 
Microsoft Excel and Eaton can provide a blank Microsoft Excel template 
locked to the correct size viewing area if requested.  
 
Once the legend details have been entered into the excel spreadsheet they 
can be laser printed onto A4 overhead transparency film, or paper. 
 
Each set of 8 legends can be inserted via the top of the face plate using the ½ 
circle indent to install the acetate sheet behind the face plate as shown below. 
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2.1.21 Window Numbering System 
Eaton/RTK have adopted the following window numbering system to aid with 
the location of the film legend and the associated alarm cards.  
 
This method is used to ensure that the legend matches the functions selected 
for the designated alarm. 
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2.1.22 USB Programming Port 
A rubber bung is used to maintain the IP rating of the annunciator and this can 
be unplugged to access the USB programming port. 
 
 

 
The USB Port is used to:- 
 

1. Upload a configuration from an existing SmartAlarm. 
 

2. Download a configuration to the SmartAlarm. 
 

3. View diagnostic data whilst fault finding.  
 
Once the user connects the Eaton supplied USB cable between a PC/Laptop 
and the USB programming port USB LED’s located just inside the face plate 
aperture indicate data exchange. 
 
 Full details of programming are provided in later sections of this manual.                                   
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3  PRIMARY POWER 
 
Primary Power – PS1 
 

 

 Primary power is connected to terminal Primary - PS1 – (~+VE) and 

(~–VE) as indicated above.  
 

 On the standard version the supply input is universal capable of 
accepting 85-264VAC 50/60 Hz or 88 to 300VDC. 
 

 As an option, which must be specified at the time of order, the primary 
supply can be 19-72VDC. 
 

 A watchdog relay, WD, is fitted as standard providing a volt free 
changeover contact for use with 3rd party devices to indicate loss or 
primary power or internal failure. 
 

 All PSU’s need to be protected with an external fuse rated at 1AT or 
equivalent MCB 

 

 

 

CAUTION
 

Power supplies must be fused externally with a 1AT fuse or suitable MCB. 
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3  AUX POWER  

Aux Power – PS2 

 
 

 Aux power is connected to terminal AUX - PS2 -  (~+VE) and (~–VE) 
as indicated above. 
 

 On the standard version the supply input is universal capable of 
accepting 85-264VAC 50/60 Hz  or 88 to 300VDC. 
 

 As an option, which must be specified at the time of order, the aux 
supply can be 19-72VDC. 
 

 A watchdog relay, WD, is fitted as standard providing a volt free 
changeover contact for use with 3rd party devices to indicate loss or 
primary power or internal failure. 

 
 All PSU’s need to be protected with an external fuse rated at 1AT or 

equivalent MCB 
 

CAUTION
 

Power supplies must be fused externally with a 1AT fuse or suitable MCB. 
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4 – SIGNAL INPUT TYPES 
 
Internally Powered 24VDC Signal Inputs 
 

 
 

 On standard SmartAlarm annunciators a fully isolated +24VDC supply 
is provided for use as a signal supply voltage.  
 

 This output is available on all +VFC terminals which are internally 
linked and protected by fuse.  
 

 An internal 160mA glass quick blow fuse, 5mm x 20mm, located on the 
Common Services Card is used to protect the output from field wiring 
errors. 
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Signal Supply Fuse Location (FCV)  
 
This is located on the Commons services card 

 
 A 160mA quick blow glass fuse 5 x 20mm is located on the PSU Card 

to protect the signal supply voltage (FCV). 
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24 or 48 VDC/ Customer Powered Inputs 
 

 

Alternative Connection Method 

 
 If the Customer is providing a signal supply voltage in the range 

24/48/VDC this supply is connected to terminal VFC (+ VIN) and 
(OVLO). If 24VDC or 48VDC Customer Powered Inputs are required 
this must be specified at the time of order as unique alarm cards are 
used for each version. 
 

 Once the supply has been connected the signal supply voltage is 
internally distributed to the signal common terminal VFC for distribution 
to the field contacts. An internal 160mA glass quick blow fuse, 5mm x 
20mm, located on the Common Services Card is used to protect the 
output from field wiring errors. If external customer supply is used then 
a suitable fuse should be fitted 
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125VDC/AC or 250VDC/AC Customer Powered Inputs 
 

 
 

 

 

 If the Customer is providing the signal supply voltage of  125VAC/DC 
or 250VAC/DC this supply is connected to terminal  VFC (+VIN) and 
(OVHI). If 125VAC/DC or 250VAC/DC Signal Inputs are required this 
must be specified at the time of order as unique alarm cards are used 
for each version. 
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125VDC/AC or 250VDC/AC Alternative Connection Method 
 

 
 

 
 Once the supply has been connected the signal supply voltage is 

internally distributed to the signal common terminal +VFC for 
distribution to the field contacts. An internal 160mA glass quick blow 
fuse, 5mm x 20mm, located on the PSU Card is used to protect the 
output from field wiring errors. If external customer supply is used then 
a suitable fuse should be fitted 

  
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5   HORN RELAYS 

HNA & HNB Horn Relays 

 
 

 Two horn relays are provided as standard HNA & HNB. 
 

 Any channel within the annunciator can be software configured to 
operate the HNA or HNB relay as required. 
 

 A volt free contact is available from each relay to switch an external 
audible or 3rd party device. 
 

 The relay is normally de-energised providing a N/O contact to activate 
the horn when an alarm occurs.  
 

 Contact rating 4A 24VDC (2A 120VAC). 
 

 If horn relays are not required the relays can be software selected to an 
alternative function. (Group Relay, Pushbutton Follower, Watchdog 
Function) 
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6 COMMON ALARM GROUP RELAYS 

GPA & GPB Group Relays 
 

 
 

 Two common alarm group relays are provided as standard GPA & 
GPB. 

 
 Any channel within the annunciator can be software configured to 

operate the GPA or GPB relay as required. 
 

 A volt free contact is available from each relay for use with 3rd party 
devices. 
 

 The Contact is configurable to N/O of N/C.  
 

 Contact rating 1A 24VDC  (0.5A 120VAC) 
 

 A reflash function can be used to interrupt the common alarm contacts 
each time a new alarm in the group occurs. 
 

 If Group Relays are not required the relays can be software selected to 
an alternative function. (Horn Relay, Pushbutton Follower, Watchdog 
Function) 
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7  REMOTE PUSHBUTTON INPUTS 
 

  
 

 Five optically coupled digital inputs are provided as standard for use 
with external N/O momentary pushbuttons.  

Pushbutton Functions 
 

 PB1 = System Test. 
 PB2 = Mute. 
 PB3 = Acknowledge. 
 PB4 = Manual Reset. 
 PB5 = First Reset. 
 PCom= supply Return* 

 
The above functions can be changed in software if required . 
 

*CAUTION 
The Pushbutton inputs are designed for bipolar operation at 24VDC as 
provided by the VAUX terminals. This is separate from Field Contact Voltage 
(FCV) selected for the alarm inputs. Customer 24VDC external supply  can be 
used, but must be suitable protected by a fuse of MCB 
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Group Inhibit Function 
As an option any of the remote pushbutton inputs, PB1 to PB5, can be 
software configured to change their use to a group inhibit function. 
 
 Any alarm can be assigned to a inhibit group and an external switch can be 
used to inhibit the alarms in the group during prolonged maintenance periods 
to prevent nuisance alarms. 
 

  
 

The above example shows the PB1input being used with a remote group 
inhibit switch. PB1 must be software configured to “Inhibit” for the function to 
work and individual channels must be software configured to the inhibit group.   
 
CAUTION 
 
The pushbutton terminals are designed for 24VDC operation only. If the 
selected Alarm Input voltage is different to +24VDC.E.G. 48VDC, 125VAC/DC 
or 250VAC/DC please note that VAUX 0V & +24VDC has to be used, or a 
suitably protected external 24VDC source. 
 
 

*CAUTION 
The Pushbutton inputs are designed for bipolar operation at 24VDC as 

provided by the VAUX terminals. This is separate from Field Contact Voltage 
(FCV) selected for the alarm inputs. Customer 24VDC external supply  can be 

used, but must be suitable protected by a fuse of MCB 
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Sleep Mode Function 
Sleep Mode is used in applications where the installation is not manned 100% 
of the time. During unmanned periods the annunciator can be placed in the 
unattended mode which disables the alarm LED’s and Audible alarms to save 
power and prevent noise pollution. 

  
The above example shows PB1 input software configured for use with a 
remote Attended / Unattended switch. PB1 must be software configured to 
“Sleep” for the function to work.  
 
When “Sleep Mode” is activated, by maintaining the switch in the closed 
position, the alarm LED’s and audibles will be disabled to save power and 
reduce noise pollution during unmanned periods. Alarms will still be captured 
in the normal way and once the switch is returned to the attended position, 
(open), the annunciator will function as normal.  
 
Whilst in sleep mode the alarm LED’s pulse in unison periodically to indicate 
that the annunciator is in sleep mode. The pulse can be disabled in software 
under the “General” Tab by selecting the check box “Sleep Without Indication” 
followed by “Confirm” . The SmartAlarm can be updated using the Tools menu  
“Send Settings” to download the changes.  
 
 

*CAUTION 
The Pushbutton inputs are designed for bipolar operation at 24VDC as 

provided by the VAUX terminals. This is separate from Field Contact Voltage 
(FCV) selected for the alarm inputs. Customer 24VDC external supply  can be 

used, but must be suitable protected by a fuse of MCB 
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8  INDIVIDUAL CHANNEL REPEAT RELAYS 
 
As an option a low power magnetically latched pulse relay can be provided on 
a per channel basis to repeat the alarm signal to 3rd party devices.   
 

 
 
Each relay can be configured in software to operate in accordance with one of 
the following:- 

Input Follower 
The relay changes state each time there is a change to the associated signal 
input contact. 

Logic Follower 
The relay changes state on alarm and remains in the abnormal state until the 
input has returned to normal and the logic has been reset using the 
pushbuttons associated with the ISA sequence set for this channel. 

Display Follower 
The relay changes state on alarm and faithfully follows the display window i.e. 
Flashing, Steady or Off depending on the alarm sequence selected for this 
channel. 

Contact Rating 
1A @ 24VDC (0.2A 120VAC) 
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9  TYPICAL SMARTALARM REAR VIEW 
 

 
 

Typical Rear View 16 Way SmartAlarm with repeat relays 
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10  INSTALLATION 

Unpacking 
Once the item has been unpacked please visually examine the unit for any 
signs of transit damage before installing the unit into the control system. If any 
damage has occurred please report the damage to the freight forwarder and 
copy Eaton. The alarm annunciator is supplied with panel mounting clamps 
locked in place, however please check all packages to ensure that no 
additional pieces are left in the box as any auxiliary items like horns, 
pushbuttons or spares kits will be packed separately.  
 
Please double check that all items listed on the packing list have been 
unpacked before disposing of any packing material. 

Mounting 
SmartAlarm annunciators are designed for panel mounting and therefore a 
suitable cut-out must  be provided to securely locate them using the Eaton 
panel mounting clamps provided on either side of the annunciator. Each 
clamp can be tightened using a phillips screwdriver.   

Dimensions for panel mounting versions 
 
8 Way  
 

 Overall:-     96mm H x 96mm W x 125mm D 
 Cut-Out :-   91 + 0.5mm H x 91 +0.5mm W 

 
16 Way  
 

 Overall:-     96mm H x 144mm W x 125mm D 
 Cut-Out:-    91 + 0.5mm H x 139 + 0.5mm W 

 
24 Way  
 

 Overall:-     96mm H x 192mm W x 125mm D 
 Cut-Out:-    91 + 0.5mm H x 187 + 0.5mm W 

 
 Maximum radius cut-out 3mm 
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19” Rack Mounting 
SmartAlarms are suitable for mounting within 19” racks using suitable filler 
plates which can be supplied by Eaton as optional items. 

Wall Mounting 
Eaton offer a full integration service where panel mounted annunciators are 
supplied within an industry standard Wall mounting Enclosure, with all 
customer connections typically wired to Weidmuller terminals for ease of 
connection to the field device. 

Floor Standing 
Eatonoffer a full integration service where panel mounted annunciators are 
supplied within an industry standard Floor Standing Enclosures, with all 
customer connections typically wired to Weidmuller terminals for ease of 
connection to the field device. 
 

 



INM P825 Rev 4  36 | P a g e  

 11  SOFTWARE  INSTALLATION 
  

Recommended Guidelines 

11.1 Security 
 
The configurator should be  Installed on a service or commissioning engineers 
laptop, in a password protected user space. 
 
It is advised that the SmartAlarm configurator provided with your order is 
stored in a safe location and that any configuration files are similarly secured. 
These include:- 
 
The supplied configuration executable file “RTKSmartAlarmInstallerV*.*.*.exe” 
A copy of the Configuration file Name.CSV ( Downloaded from the 
Annunciator) 
Annunciator activity log Name.txt 
 
All of the above explained below:- 

11.1.1 Configuration executable  
 
This is the file provided with the unit that unpacks the configurator to a laptop 
or PC. This can also be downloaded from the MTL website at 
 https://www.mtlinst.com/resources/datasheets/filter/new_smartalarm_annunciator 
 
Please ensure that this file is kept in a secure location  

11.1.2 Configuration file 
 
This file is specific to each annunciator and contains all the settings pertaining 
to the setup. It is recommended that the latest file is dated and lodged in a 
safe location under lock and key. Any changes made to the unit must be 
reflected in a new .csv file. 

11.1.3 Log file 
The log file indicates every instance of the configurator being launched and 
any activity that trigger an action such as importing or exporting a .CSV 
configuration file, a sample of the file is shown below 
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11.2 Other security Considerations 
 

 The SmartAlarm should be located in a secure environment with 
access only provided to authorised personnel 

 
 If within a public walk way, the unit should be mounted behind a locked 

viewing window 
 

 Unit firmware is not field upgradable and needs to be returned to base 
if required  
 

 The unit can be reset back to factory default to obviate any erroneous 
setting11.4 Activity log 

 
This log is located in the file path where the configurator is installed. This can 
be found by right clicking the SmartAlarm shortcut,  selecting properties and 
clicking on the open File Location  
 

 
The log folder contains the log text file and if the unit has been scanned the 
scan document. 
 

11.4.1 Log file 

The log file indicates every instance of the configurator being launched and 
any activity that trigger an action such as importing or exporting a .CSV 
configuration file, a sample of the file is shown below 
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11.4.2 Scan File 
 
This file is created when the scan function is used within the configurator. The 
scan data includes the type of card fitted into the unit and their firmware 
versions. 
 

 
 
 
 
Configuration Software is provided free of charge on a conventional CD or the 
software can be downloaded from our Website:- 
https://www.mtl-
inst.com/resources/datasheets/filter/new_smartalarm_annunciator 
  in the section labelled SmartAlarm Software 
 
To install the software Click on the RTKSmartAlarmInstallerV***    
(*** = Version Number)  
 
Software requirements are Windows 7 and above 
 
 
Please select “Run” to start the install process.  
 
            
 

 Select “Run” which will list the components to be installed 
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 Select “Next” which will show the default destination folder 
 
 

 This followed by a license agreement. Click on “ I Agree” to proceed 
 

 
 
 
 
 
 

 Select “I Agree” to install the application and once complete select 
“Close” 
 

 

           
 

 The desk top will show a quick launch icon – please select this Icon to 
open the application. 

 
 Select the “File” menu which will prompt the user with the following 

options. 
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12  – AUTO DETECT HARDWARE. 
 
To Auto Detect the settings within a SmartAlarm.  
 

 Open the Eaton SmartAlarm configuration software using the 
“SmartAlarm” quick launch icon located on the desktop. 

 
 Apply primary power to the SmartAlarm. 

 
 Remove the rubber bung on the front of the SmartAlarm to access the 

USB programming port. 
 

 Connect the Eaton supplied USB cable between the PC/Laptop and 
the SmartAlarm. 
 

 When you initially plug-in the USB cable to the SmartAlarm you will 
notice a green LED near the USB port flash to indicate communication. 
 

 From the “Comport” tool bar select the USB Com. port you will be using 
to communicate with the SmartAlarm. Note the Comport No varies 
depending on the devices connected to each PC and the USB port 
being used therefore more than one com port may be identified in the 
list. 
 

 Use the “”File” menu to select “Auto Detect” and note the green 
progress bar increases whilst installation is in progress and once 
complete an Auto Detect Complete message appears on the desk top  
- please select “OK”. 
 

 Once Auto Detect is complete all of the settings shown will be an exact 
copy of those held in the associated SmartAlarm. 

 
You are now ready to use the software as required. 
 
Before any configuration changes take place Eaton, recommend a Master 
copy is saved to the PC/Laptop using the “File” menu – “Export CSV File” this 
ensures a master copy is available if you wish to revert back to the initial 
settings. 
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13  IMPORT CSV FILE 
 

Open Configuration 
Configurations are saved in CSV format and can be re-installed as required. 
 
From the “File” menu select “Import CSV File” which will allow standard 
windows navigation to locate the saved configuration. 
 
Once located select “Open” to install the previously saved configuration 
settings. 
 
Please note this will overwrite all existing settings. 

 

14  EXPORT CSV FILE 
 

Save Configuration 
Configurations are saved in CSV format and can be saved as required. 
 
From the “File” menu select “Export CSV File” which will allow standard 
windows navigation to save the configuration. 
 
Once saved the configuration can be viewed in Microsoft Excel format and 
edited as required.  
 
After changes have been made the CSV file can be imported as described in 
the previous section. 
 
 
Eaton recommend a copy of each SmartAlarm configuration is saved for 
future reference as required. 
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15  CREATE A NEW SYSTEM 
 
 
Select “Create New SmartAlarm” is only used during manufacturing to select 
the order specific features required per SmartAlarm 
 
This function is not used by customers 
 
 



INM P825 Rev 4  43 | P a g e  

16  SYSTEM SETTINGS 
 

 
 

Auto Detect 
The user is able to Auto Detect the configurations of an existing SmartAlarm 
once they have loaded the SmartAlarm configuration software onto a suitable 
PC and connected the USB Cable to the communication port located behind 
the rubber bung on the front of the SmartAlarm. 
 
The auto detect facility is accessed via the “File” menu as shown above.  
 
Once selected all of the settings stored within the SmartAlarm are read into 
the software allowing the user to view, save or modify the configuration as 
required. 
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View 
The following settings are available under the “View” menu. 
 
 

Advanced 
As standard the configuration software restricts some of the features to 
simplify selection of features. In more complex applications additional menus 
are available for example. Increased number of groups or custom sequences 
and these are accessed via the “View Advanced” menu. 

 

 

Front View of Annunciator 
Selecting the “View” menu – “Front” menu provides a graphic of the alarm 
fascia to aid programming. 
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Tools 
The following settings are available under the “Tools” menu 
 

 

Send Settings 
Once the SmartAlarm has been connected to a suitable PC/Laptop via the 
Eaton supplied USB Cable the user is able to download any configuration 
changes to the unit as required. Eaton recommend that before downloading 
the customer uploads the original settings and saves them on the PC/Laptop 
for future reference or as a backup. 

Receive Settings 
Once the SmartAlarm has been connected to a suitable PC/Laptop via the 
Eaton supplied USB Cable the user is able to upload the configuration 
settings from the unit as required. Before any changes are made Eaton 
recommend that a copy of the original settings are saved for future reference 
or as a backup. 

Restore Default Settings 
If required the user is able to return the unit to the factory default settings, 
however please note this will revert ALL settings within the Annunciator so 
should only performed with caution. 
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Diagnostics 
Once the SmartAlarm has been connected to a suitable PC/Laptop via the 
Eaton supplied USB Cable the user is able to select Diagnostics to check the 
dynamic status of the SmartAlarm. 
 

Set Structure 
Please consult factory before modifying the structure of a supplied 
Annunciator. 

Scan Unit 
This allows the user to identify the address, card type, software version and 
software revision number for the cards within the SmartAlarm. This will aid 
fault finding or spare parts identification. 

Test Tools 
Production use only. 
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General Tab 
The fields listed under the “General” tab allow the user to uniquely identify 
each Alarm Annunciator System to aid with the storage and retrieval of 
configuration data.  
 

 
 
 
The user can update any of the fields within the software but the changes will 
only be saved after the “Confirm Settings” control button is pressed using a 
left mouse click. Any changes will need to be sent to the annunciator via the 
Tools menu “Send Settings”. 

Plant Name 
Allows the user to allocate a unique name to define the location of the device.  

Description 
This field is used to identify the specific plant area or annunciator function 
within the plant.  
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Tag No. 
This field allows a Customer assigned number to be used to identify a unique 
alarm annunciator.  

Serial No. 
A serial number is automatically provided once the software is communicating 
with the alarm annunciator. 

Address Offset 
This allows the user to offset the Node address to match the application. 

Sleep Without Indication 
Selecting this feature inhibits the heart-beat pulse which cyclically pulses the 
alarm LED’s whilst the unit is in Sleep Mode (Full details of Sleep Mode are 
provided within this manual). 
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CS Relays (Common Service Relays) 
Each channel within the annunciator can be assigned to a single or multiple 
groups. The group can be software linked to any of the common relays to 
provide contact outputs for use with 3rd Party devices. 
 
The fields listed under the “CS Relays” tab allow the user to configure the 
common system relays to follow groups as required. 
 

 
 

Horn A - HNA 
The default setting for this relay is Horn A / HNA, the relay is normally de-
enegised and provides a N/O contact for use with external audibles / 3rd party 
devices. The relay will activate on alarm and will return to normal after Mute or 
Acknowledge have been pressed. The relay must be assigned to a group and 
the group type needs to be set as “Audible” for the relay to operate correctly. 
 

 The coil state can be set to Normally Energised or Normally De-
Energised, by selecting the required feature using the Drop-down 
menu shown next to the coil status field. 
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Horn B - HNB 
The default setting for this relay is Horn B / HNB, the relay is normally de-
energised and provides a N/O contact for use with external audibles / 3rd party 
devices. The relay will activate on alarm and will return to normal after Mute or 
Acknowledge have been pressed. The relay must be assigned to a group and 
the group type needs to be set as “Audible” for the relay to operate correctly. 
 

 The coil state can be set to Normally Energised or Normally De-
Energised, by selecting the required feature using the Drop-down 
menu shown next to the coil status field. 

Group A - GPA 
The default setting for this relay is Group A / GPA, the relay is normally de-
energised and provides a configurable contact for use with 3rd party devices. 
The relay will activate on alarm and will return to normal after the process has 
returned to normal and the alarm has been cleared. The relay must be 
assigned to a group and the group type needs to be set as “Alarm” for the 
relay to operate correctly. 
 

 A latching Relay is used for the Group Relay function allowing the 
contact state can be set to Normally Open or Normally Closed by 
selecting the required feature using the Drop-down menu shown next 
to the coil status field. 

Group B - GPB 
The default setting for this relay is Group B / GPB, the relay is normally de-
energised and provides a configurable contact for use with 3rd party devices. 
The relay will activate on alarm and will return to normal after the process has 
returned to normal and the alarm has been cleared. The relay must be 
assigned to a group and the group type needs to be set as “Alarm” for the 
relay to operate correctly. 
 

 A latching relay is used for the Group Relay function allowing the 
contact state can be set to Normally Open or Normally Closed by 
selecting the required feature using the Drop-down menu shown next 
to the coil status field. 

Optional Settings 
The following options apply to any of the common relays. 

Assigning Relays to Groups 
Any relay can be set to follow any group within the annunciator using the drop 
down menu. 
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Reflash Function 
When using the GPA or GPB common alarm relays a reflash function can be 
used to indicate that multiple alarms are occurring within the group. When an 
alarm within the group activates the relay will change state and each time a 
new alarm occurs within the same group the relay will revert to normal and 
reactivate, (Reflash). The drop-down menu which allows selection of the 
group includes selection of the group and reflash as an option. 

Disable in System Test 
A relay can be prevented from operating during System Test by selecting the 
“Disable in System Test” check box shown on the previous page. For example 
you may not need the audible to sound during system test, this feature allows 
the user to disable the relay during the test cycle. 

Disable in Sleep Mode 
Sleep mode is an optional setting which allows the user to disable the visual, 
audible and common relays during unmanned periods. 
 
A relay can be prevented from operating whilst the annunciator is in sleep 
mode by selecting the “Disable in Sleep Mode” check box shown above. For 
example you may wish to disable the horn relays but allow the common alarm 
relays to continue to operate as normal during unmanned periods. 

Reflash Pulse Length 
As indicated above the group relays can have a reflash feature enabled which 
interrupts the output each time a new alarm occurs within the group. The 
reflash pulse length can be set in tenths of a second to suit individual 
applications. 

Alternative Functions for any Relay 
The drop-down menu provided next to the “Assignment Field” of each relay 
allows the user to set any of the Relays to:- 
 

 Any group (Group-1 to Group-30). 
 

 Any group with Reflash enabled (Group-1 to Group-30). 
 

 Pushbutton Follower where the relay will faithfully follow the operation 
of any one of the following Pushbutton functions:- Lamp Test, Mute, 
Ack, Reset, 1st Reset or System Test. 
 

 All faults Relay where the relay activates if any fault is detected within 
the Annunciator. 
 

 Field Contact fault where the relay activates when the signal supply is 
lost which can be used to flag 3rd Party devices. 
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Local Pushbuttons 
 

 

 
Each SmartAlarm is equipped with four integral tactile pushbuttons used to 
control the operational sequence of the annunciator. The local pushbuttons 
tab allows the user to change the function of a pushbutton if required. 
 
A drop-down menu provided per pushbutton allows the user to select 
alternative functions. For example System Test is used as standard but the 
user may prefer Lamp Test as an option. 
 
Once the alternative function has been selected the user will need to press 
“Confirm” and the changes will need to be downloaded to the annunciator via 
the tools menu. 
 
Any internal pushbutton can be assigned to a pushbutton group and any 
channel can be set to match the associated group.  
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For example:-  Channel-1 to 4 can be set to Pushbutton Group-1 and the 
internal pushbuttons can be set to control Pushbutton Group-1. Only alarms 
within the group would be controlled by the internal pushbuttons.  
 
The remaining alarms can be assigned to Pushbutton Group-2 and these can 
be controlled by external pushbuttons if required. 
 

Remote Pushbuttons 
 

 

 
Each SmartAlarm is equipped with five optically coupled digital inputs which 
can be used with normally open momentary pushbuttons to control the 
operational sequence of the annunciator. The remote pushbuttons tab allows 
the user to change the function of a pushbutton if required. 
 
A drop-down menu provided per pushbutton allows the user to select 
alternative functions. For example System Test is used as standard but the 
user may prefer Lamp Test as an option. 
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Once the alternative function has been selected the user will need to select 
“Confirm” and the changes will need to be downloaded to the annunciator via 
the tools menu – “send settings”. 
 
Any external pushbutton can be assigned to a pushbutton group and any 
channel can be set to match the associated group.  
 
For example:-  Channel-1 to 4 can be set to Pushbutton Group-1 and the 
internal pushbuttons can be set to control Pushbutton Group-1. Only alarms 
within the group would be controlled by the internal pushbuttons.  
 
The remaining alarms can be assigned to Pushbutton Group-2 and these can 
be controlled by external pushbuttons if required. 
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Inhibit Function 
As an alternative any of the five pushbutton inputs can be set for use with an 
external inhibit switch. The inhibit switch should be connected between +VB 
and the associated pushbutton input. When the switch is in the closed position 
all alarms within the inhibit group will be prevented from operating until the 
inhibit switch is returned to normal  
 
It is possible to assign any channel with the Annunciator to be included in 
inhibit group-1 to inhibit group-8 as required 
 
To link a channel to an inhibit group first select the associated LED within the 
software faceplate to access the “channel”-tab.  
 
Under the “Manual Inhibit” field assign the channel to an inhibit group as 
required and select “Confirm” followed by “Tools” – “Send Settings” to 
download the settings to the Annunciator. 
 

Assigning Channel to Inhibit Groups 
 

 
 
In the above example channel 3 has been set to Inhibit Group 1 
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Assigning a Remote Pushbutton Input to Inhibit 
 

 
 
In the above example Remote Pushbutton 5 has been set as the Input for 
Group2  Inhibit Switch  
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Sleep Mode 
As an alternative any of the five pushbutton inputs can be set for use with an 
external inhibit switch used to place the Annunciator into Sleep Mode during 
unmanned periods. The sleep mode switch should be connected between 
PCom and the associated pushbutton input.  
 

 
 
PB5 for remote pushbutton-5 Used as a Sleep Mode Input. 
 

CAUTION 
The common return for the external pushbuttons is terminal PCom  and this 
terminal will provide the same voltage level as the internally generated signal 
contact supply 
 
 

CAUTION 
On standard systems +24VDC is used, however  125VDC may be present if 
HV signal inputs were specified at the time of order. In this event  
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Assigning a Remote Pushbutton Input to Sleep Mode 

 
 
 
 
 
Whilst in sleep mode the audible alarms are disabled and the individual 
channel LED’s are disabled to save power and prevent noise pollution during 
unmanned periods.  
 
When the switch is maintained in the closed position the Annunciator will 
remain in sleep mode until the switch is returned to normal. 
 
Please note:- 
 

 The individual channel repeat relays will continue to operate as usual 
during sleep mode to allow notification of alarms to 3rd Party devices 

 
 The two group relays GPA, GPB & the Watchdog relay can be 

prevented from operating in sleep mode under the Common Services 
Relays – Tab if required. 

 
In the above example Remote Pushbutton 5 has been set as an input for the 
external “Attended / Unattended” sleep mode switch. 
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Common Relay Operating In Sleep Mode 
Each of the common relays can be prevented from operating in “Sleep” mode 
if required. 
 
For example during unmanned periods the two horn relays can be prevented 
from operating to prevent noise pollution whilst the 2 Group and 1 Watchdog 
relay can continue to operate as normal. 

Inhibiting Common Relays During Sleep Mode 
 

 
 
In the above example HNA and HNB horn relays will not operate during sleep 
mode.  
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Sleep Mode Heartbeat 
To indicate that the annunciator is in sleep mode the associated alarm LED’s 
pulse periodically (heart beat pulse).  
 
In some applications this pulse may not be required and it can be disabled by 
selecting “Sleep Without Indication” under the “General” tab as shown in the 
below screenshot. Once the setting has been made select “Confirm” – “Tools” 
menu – “Send Settings” to download the changes to the SmartAlarm. 

Disabling Sleep Mode Heartbeat 
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Horn 
 

 
 
As standard the user can assign any channel to any group within the 
annunciator.  
 
A maximum of 32 groups are available however to simplify configuration in the 
normal view only 8 groups are shown. 
 
The remaining groups can be accessed if the user selects “View” followed by 
“Advanced”. 
 
Once the alarms have been assigned to groups and the group type has been 
set to “Audible” the group or groups can be linked to the internal audible as 
required.  
 
For example 
 

 If channels 1 to 8 have been set to Group-1  
 

 The Group type has been set to “Audible” 
 

 The internal horn-1 can be linked to the group by selecting Group-1 
under the horns tab  

 
Screen shot shown above for reference. 
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Auto Acknowledge 
 

 
 
In applications where the annunciator is left unattended for long periods noise 
pollution can be prevented using the automatic acknowledge feature.  
 
This feature is used to assign the automatic acknowledge function to the 
associated group. 
 
In the normal view 8 groups are shown as standard and the remaining groups 
can be accessed if the user selects “View” followed by “Advanced” 
 
The “delay” field allows the user to enter a time delay in seconds and once set 
the annunciator will automatically acknowledge the alarms after the pre-set 
period has elapsed. 
 
The automatic acknowledge feature will silence the audible and the visual 
alarm will also be acknowledged in accordance with the selected ISA 
sequence. 
 
Please note as the timer is triggered from the horn circuit the user must select 
automatic acknowledge OR automatic silence as either function will stop the 
timer. 
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Auto Silence 
 

 
 
In applications where the annunciator is left unattended for long periods noise 
pollution can be prevented using the automatic silence feature. 
 
This feature is selected under the auto silence tab where the user can assign 
the automatic silence function to the associated group. 
 
In the normal view 8 groups are shown as standard and the remaining groups  
can be accessed if the user selects “View” followed by “Advanced” 
 
The “delay” field allows the user to enter a time delay in seconds and once set 
the annunciator will automatically silence the audible after the pre-set period 
has elapsed. 
 
Please note  
 

1. This feature only silences the audible alarm the visual alarm will 
continue to operate in accordance with the selected ISA sequence. 

 
2. The timer is triggered from the horn circuit therefore the user must 

select automatic acknowledge OR automatic silence as either function 
will stop the timer. 
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Groups 
 

 
 
Any channel within the Annunciator can be set to be part of Group-1 to Group-
32 as required. 

Group Types 

First-Up Group 
In applications where the annunciator is monitoring alarms which are 
interlinked for example: Compressor and Turbine monitoring it is important to 
identify the first alarm to occur within the group as it simplifies and quickly 
identifies the root cause of failure. 
 
Once the alarms have been assigned to a group the “Groups” function needs 
to be identified using the drop-down menu provided against each group.  
 
For example if channel 1 to 8 have been assigned to Group-8 and they are all 
part of the same first-up group the drop-down menu for Group-8 should be set 
to “First-Up Group” 
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Input Group 
Input Groups are typically used with Common Relays GPA and / or GPB and 
3rd party devices to identify that an alarm / alarms with a group are in the 
abnormal condition. 
 
With “Input Groups” the common relay would activate when an alarm in the 
group occurs and the common relay would automatically return to normal 
when the Input returns to normal.  
 
Please note if multiple channels are used with the Group - ALL of the alarms 
must be in the non-alarm state before the common relay returns to normal.   
 
Any channel within the Annunciator can be assigned to any group and once 
assigned the “Groups” function needs to be set to “Input Group” using the 
drop-down menu provided against each group as required. 
 
Once set the Common Relay / Relays need to match to follow the Group as 
required. 

Audible Group 
Any channel within the Annunciator can be assigned to any group and once 
assigned the “Groups” function needs to be set using the drop-down menu 
provided against each group 
 
For example if channel 1 to 8 have been assigned to “Group-1” and they are 
all part of the same audible group the drop-down menu for Group-1 should be 
set to “Audible Group” 
 
Once selected the Internal Audible or Common Relays should be set to follow 
the associated horn group as required. 

Ring back Audible Group 
When using ISA R – Ring Back Sequence the associated LED slow flashes to 
indicate to the operator that an alarm has returned to normal. 
 
In addition to the visual prompt the annunciator can sound an audible to 
prompt the operator that Reset can be pressed to clear the alarm. 
 
Alarms set to alarm sequence ISA R (Ring Back) and a Group for example 
Group-7 can be set to a RB (Ring Back) Audible Group using the drop down 
menu provided against Group 7. 
 
Group 7 can be typically assigned to HNB Horn Relay B and an external horn 
differing in tone from the integral audible can be used to identify that an alarm 
has returned to normal. 
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Grouping Example 
The following steps identify how to set the Group, Group Type and assign the 
Group to Internal Horn and Common Relays. 

 
 
In the above example ALL channels have be set to “Group 1” 
 
Assigning the Group Type 
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Grouping Example 1 

 
 
In the above example the “Group Type” has been set to Audible. 
 
 
Assigning a Group to the Internal Audible 
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Grouping Example 2 

 
 
In the above example the internal horn has been set to follow “Group 1” 
 
Assigning a Group to a Common Relay  
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Grouping Example 3 

 
 
In the above example Common Relay Horn A / HNA has been set to follow 
“Group 1” 
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Communications 
 

 
 
As an option the Annunciator can be provided with Modbus RTU Protocol for 
use with 3rd Party devices. 
 
When this option is included the Comm’s – Tab provides access to the fields 
used to set the following:- 
 

 Protocol – Modbus RTU 
 

 Baud Rate – 38400, 19200 or 9600 
 

 Parity – Even or Odd 
 

 Normal Delay – Set in mS 
 

 Communications Address Offset – Set as required to match the 3rd 
Party device 
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17  INDIVIDUAL CHANNEL SETTINGS 

Configuring Individual Channels 
To configure individual channels the user must first select an LED on the 
associated annunciator faceplate using a left mouse click as typically shown 
below for channel-1.  
 

 
 

Configuring Selective channels 
Selective channels can be highlighted if the “Ctrl” key on the keyboard is held 
down while you select the required LED icons (Channels). Once the channels 
have been selected the user is able to navigate between features and select 
them as required. The background colour for a selected feature is white 
however if the background colour changes to blue it indicates that the 
selected channels currently have varying settings stored and the user will be 
prompted if they wish to proceed in setting them to the same function. 
 
Configuring Multiple channels  
Multiple channels can be highlighted if the user selects the first LED and holds 
down the shift –key on the keyboard to select the last LED in the group. For 
example if you select channel-1 and hold down the shift-key and select 
channel-8 all channels within the range will be selected. 
 
To implement changes the user must select the “Confirm” icon and download 
the configuration to the SmartAlarm using the “Tools” menu – “Send Settings” 
as required 
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Channel 
The following options are available “Channel” tab 
 

 

Alarm Legend 
Each channel needs to have a unique legend to help the operator identify the 
alarm. The user can type an alarm description into the “alarm legend” field 
and dropdown menus allow selection of window colour, font, style and size to 
suit each application.  

Manual Inhibit 

Each channel can be manually inhibited within the software or a number of 
channels can be assigned to an inhibit group to allow a remote switch input to 
be used as a group inhibit enable. To manually inhibit a channel the user 
selects the associated LED icon and then uses a left mouse click to select the 
inhibit input tick-box under the channel tab.  

Group Inhibit 
If inhibit groups are required channels should be selected to the required 
group and the group should be assigned to a remote pushbutton/switch input 
as described later in the manual. 
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To implement changes the user must select the “Confirm” icon and download 
the configuration to the SmartAlarm using the “Tools” menu – “Send Settings” 
as required 
 

Auto Shelving 
On systems supplied with the sequence of event recording option a faulty 
alarm loop or loose cable can quickly flood the associated event buffers. Auto 
Shelve allows the user to configure: 
 
Function  Description 
 
Alarm Count The maximum number of alarms the user believes will 

occur with a set period before the alarm count is 
considered abnormal. 

 
Count Period The required time period in seconds 
 
If the number of input events exceeds the abnormal count within the time 
period the input will be automatically shelved and a dated and timed message 
will be generated to inform the user that auto shelving has occurred on the 
specific channel. Events that occurred prior to the auto shelve are stored in 
buffer to aid fault finding and the alarm will return to normal once the input is 
within operating parameters.  
 
 
To implement changes the user must select the “Confirm” icon and download 
the configuration to the SmartAlarm using the “Tools” menu – “Send Settings” 
as required 
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Input 
The following options are available under the “Input” tab 
 

 

Contact Type 
A dropdown menu allows the user to assign the non-alarm contact state for 
each channel. The default setting is Normally Open (Closed to alarm) with an 
optional setting to Normally Closed (Open to alarm). If serial inputs are 
required please select the tick-box to the left of “Remote” 

Delay Timers 

Each channel is equipped with timers allowing the user to delay the activation 
and/or the return to normal time period. 

Abnormal Delay (mS) 
This option prevents the alarm occurring before a pre-set time period has 
elapsed. If an alarm occurs the timer will automatically start and the alarm will 
occur as soon as the delay period has passed. 
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Normal Delay (mS) 
This option prevents the alarm returning to normal until the pre-set delay 
period has elapsed.  
 
The default setting for the activation and deactivation is 10mS but can be 
selected between 1 and 65,000mS as required. 
 
 
 

Remote 
This field is used to configure each input as hardwire (Normally Open / 
Normally Closed) or Serial Input (Remote). 
 
If the “Remote” check-box is enabled the input will activate via Serial 
Communications. 
 
If the “Remote” check-box is unchecked the input will activate via a 
conventional hardwired contact input (N/O or N/C). 
 
 
To implement changes the user must select the “Confirm” icon and download 
the configuration to the SmartAlarm using the “Tools” menu – “Send Settings” 
as required 
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Relay 
As an option which must be specified at time of order, each channel can be 
provided with a repeat relay on the 8, 16 and 24 way versions of the 
SmartAlarm.  
 

 If the relay tab is greyed out repeat relays have not been fitted.  
 

 If the relay tab is active the following settings are available.  
 

 
 

Coil Status 
The non-alarm coil state of each relay can be set to Normally Energised or 
Normally De-Energised using the dropdown menu as required. 
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Relay Function 
The function of each relay can be set to one of the following modes using the 
dropdown menu:- 
 

 Follow Input 
In this mode the relay will operate when the signal contact activates 
and returns to normal. 

 
 Follow Alarm 

In the mode the relay will activate on alarm and will only change state 
when the input returns to normal and the alarm has been cleared. 

 
 Follow Display 

In this mode the relay will faithfully follow the display i.e. ON / OFF or 
Flashing to match the alarm sequence. 

Abnormal Delay 
Each repeat relay can be set to activate after a pre-set time has elapsed. 
 
The default is 10mS and the user can increment this in 1mS steps upto a 
maximum of 65,000mS. 

Normal Delay 
Each repeat relay can be prevented from returning to normal unless the 
change in state has occurred for longer than the pre-set time period. 
 
The default is 10mS and the user can increment this in 1mS steps upto a 
maximum of 65,000mS. 
 
To implement changes the user must select the “Confirm” icon and download 
the configuration to the SmartAlarm using the “Tools” menu – “Send Settings” 
as required 
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Sequence  
The following settings are available under the “Sequence” tab 
 
Within the annunciator market a common standard has been adopted by all 
key manufacturers and end users with regards to operational sequences. 
These standards are used worldwide to define the visual indication, audible 
alarm and the action the operator must take to control the annunciator.  
 
The Instrument Society of America provide full details of each alarm sequence 
within ISA 18.1-1979 (R1992) and Eaton are fully compliant with the stated 
sequences. The most common sequences are detailed in a separate section 
of the manual. 
 
 

 

ISA Sequences 
To define a sequence the user can simply select any of the listed ISA 
sequences on a per channel basis using the dropdown menu as shown 
below. 
 
The additional features shown i.e. Basic Sequence, First-Up Sequence and 
Sequence Options are only visible when the user selects view-“Advanced” 
and these options are used for custom sequences. 
 
To implement changes the user must select the “Confirm” icon and download 
the configuration to the SmartAlarm using the “Tools” menu – “Send Settings” 
as required 
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PB Groups 
The following settings are available under the “PB Groups” tab. 
 

 

Global Pushbutton Group 
Pushbutton functions are available within the SmartAlarm to test or control the 
alarms in accordance ISA-S18.1 Alarm Sequences. 
 
In standard applications all channels are assigned to pushbutton group-1 
however, the user can enable or disable any of the functions on a per channel 
basis as required. 

Multiple Pushbutton Groups 
In more complex applications each channel can be assigned to any one of 8 
pushbutton groups. To access the additional groups the user must select 
“View” followed by “Advanced” view. 
 
As a default Pushbutton Group-1 is assigned to the internal pushbuttons and 
any additional pushbutton groups would require the use of external 
pushbuttons. 
 
To implement changes the user must select the “Confirm” icon and download 
the configuration to the SmartAlarm using the “Tools” menu – “Send Settings” 
as required 
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Groups  
The following settings are available under the “Groups” tab. 
 
Each channel within the SmartAlarm can be linked to a single or multiple 
alarm groups. Groups-1 to 8 are shown as standard and additional groups are 
available via the “View” – “Advance View” menu. 
 
Groups are typically used to provide summary alarm information for use with 
3rd Party devices (DCS/PLC/SCADA/Supervisor Consoles). 
 

 

 
Channels can be assigned to a single or multiple groups using a left mouse 
click on the associated tick-box.  
 
To implement changes the user must select the “Confirm” icon and download 
the configuration to the SmartAlarm using the “Tools” menu – “Send Settings” 
as required 
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18  ALARM SEQUENCES 
Within the annunciator market a common standard has been adopted by all 
key manufacturers and end users with regards to operational sequences. 
These standards are used worldwide to define the visual indication, audible 
alarm and the action the operator must take to control the annunciator.  
 
The Instrument Society of America provide full details of each alarm sequence 
within ISA 18.1-1979 (R1992) and Eaton are fully compliant with the stated 
sequences. The most common sequences are detailed within this section of 
the manual. 
 
To define a sequence the user can simply select any of the listed ISA 
sequences. 
 
Pushbuttons  
Four integral pushbuttons and five remote pushbutton inputs are provided on 
the annunciator unit to allow the user to be able to control any of the available 
sequences which can be set on a per channel basis. 
 
Functional Test – is used to simulate an input on all channels and therefore 
all windows and horn circuits will operate in accordance with the selected ISA 
sequence and additional pushbuttons will need to be pressed to step through 
the alarm sequence to return the unit to its normal state. 
 
Mute – is used to silence the audible alarm whilst allowing the associated 
alarm window to continue to operate in accordance with the selected ISA 
sequence. 
 
Acknowledge – is used to silence the alarm and change the state of the 
associated alarm window in accordance with the selected ISA sequence. 
 
Reset – is used to return the alarm to the normal off state once the Input has 
returned to the normal condition.  
 
As an option functional test can be replaced by Lamp Test and Reset can be 
replaced by First Reset if required. 
 
Audible Alarms 
Each channel within the annunciator can be set to operate either of the two 
integral audible alarms or they can be assigned to common relays configured 
as horn relays as required. 
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Additional Features 
 
Automatic Reset 
Once a channel has been acknowledged and its input has returned to normal 
the alarm can be set to automatically reset without the operator having to 
press the reset pushbutton. 
 
Non Latch Sequence – (No Lock In) 
Alarms can be set to non lock-in, which allows the alarm to automatically 
return to the non alarm state as soon as the signal input returns to normal. 
 
Ringback Sequence 
Ringback sequence is used to inform the operator both visually and audibly 
that an alarm condition has cleared and the channel can be reset to its normal 
off state. When a contact returns to normal the associated window will flash at 
approx ½ the speed of a normal alarm and the audible will sound. This 
identifies the specific alarm and informs the operator that the alarm can be 
reset to its normal off state.  
 
First Up Sequences 
When monitoring devices with interlinked functions such as a turbine or 
compressor it is often important to know the specific alarm that occurred first, 
as it will invariably result in cascade of secondary alarms. This allows the 
operator to focus on the root cause of failure and therefore limits the 
downtime and associated costs. This is achieved by having the first-up alarm 
flashing in a different manner compared to the subsequent alarms. Four 
different first-up sequences are available F0, F1, F2 and F3 as detailed below 
and in the following sequence tables.  
 
F0 The standard mode adopted by Eaton Eelectric, which indicates the first-

up alarm by flashing at twice the rate of subsequent alarms.  
F1 In this mode subsequent alarms appear in the acknowledged state, hence 

they do not flash. The audible device does not operate when subsequent 
alarms occur, unless still operating from the first alarm. The acknowledge 
pushbutton will reset the first-up indication. 

F2 In this mode all subsequent alarms do not flash, they will however operate 
the audible device. The acknowledge pushbutton will reset the first-up 
indication. 

F3 In this mode initial alarms appear with an intermittent flash rate and 
subsequent alarms flash at a steady rate. On acknowledge subsequent 
alarms revert to the steady on state and only the first alarm continues to 
flash at a slower rate.  

 
Please note auto reset and non lock- in functions are not recommended when 
using first up sequences as the true sequence of events cannot be 
guaranteed. 
 
The most common sequences are detailed below:- 
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ISA A – Automatic Reset – Lock In 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL
OR NORMAL

ALARM
FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE
WHILE ABNORMAL

RETURN
 TO NORMAL

 TO 
ABNORMAL

ACKNOWLWDGE
WHILE NORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL
OR NORMAL

SILENT

ON
ACKNOW

 
Sequence Features 
 

1. Acknowledge and test pushbuttons. 
2. Alarm audible device 
3. Lock In of momentary alarms until acknowledged 
4. The Audible device is silenced and the flashing stops when 

acknowledged. 
5. Automatic reset of acknowledged alarms when the process has 

returned to normal 
6. Operational test 
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ISA A-1-2 – Automatic Reset – Silence Pushbutton Interlock 
 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 
OR NORMAL

ALARM
FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

SILENCE

RETURN
 TO NORMAL

 TO 
ABNORMAL

ACKNOWLEDGE

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL 
OR NORMAL

SILENT

FLASHING
SILENCE

ABNORMAL 
OR NORMAL

PROCESS

VISUAL

AUDIBLE

SEQUENCE

ON

SILENT

ACKNOW

 
 
 
Sequence Features 
 

1. Acknowledge, silence and test pushbuttons. 
2. Alarm audible device 
3. Lock In of momentary alarms until acknowledged 
4. Silence pushbutton must be pressed before acknowledge 
5. Silence stops the audible alarm only 
6. The flashing stops when acknowledged. 
7. Automatic reset of acknowledged alarms when the process has 

returned to normal 
8. Operational test 
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ISA A-4 – Automatic Reset – Non Lock In 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 
OR NORMAL

ALARM
FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE
WHILE ABNORMAL

RETURN
 TO NORMAL

 TO 
ABNORMAL

RETURN 
TO NORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL 
OR NORMAL

SILENT

ON
ACKNOW

 
Sequence Features 
 

1. Acknowledge, and test pushbuttons. 
2. Alarm audible device 
3. Non Lock In of momentary alarms 
4. The audible device is silenced and the flashing stops when 

acknowledged. 
5. Automatic reset of alarms when the process has returned to normal 

before or after acknowledge (Non Lock In) 
6. Operational test 
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ISA A-4-5 – Automatic Reset – No Flashing 
 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 
OR NORMAL

ALARM
ON

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE
WHILE ABNORMAL

RETURN
 TO NORMAL

 TO 
ABNORMAL

RETURN 
TO NORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL 
OR NORMAL

SILENT

ON
ACKNOW

 
 
 
Sequence Features 
 

1. Acknowledge, and test pushbuttons. 
2. Alarm audible device 
3. The visual alarm does not flash 
4. Non Lock In of momentary alarms 
5. The audible device is silenced when acknowledged. 
6. Automatic reset of acknowledged alarms when the process has 

returned to normal 
7. Operational test 
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ISA A-4-5-6 – Status  
 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 
OR NORMAL

ALARM
ON

SILENT

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL
RETURN

 TO NORMAL
 TO 

ABNORMAL

Sequence Features 
 

1. Test pushbutton. 
2. No alarm audible  
3. The visual alarm does not flash 
4. Non Lock In of momentary alarms 
5. Automatic reset of alarms when the process has returned to normal 

before or after acknowledge (Non Lock In) 
6. Operational test 
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Please Note:- 
 
The drop down menu within the configuration software allows the user to 
select ISA Sequence A-4-5-6 to obtain Status Only indication.  
 
If the audible alarm sounds on a channel that has been set to Status only 
please check that the channel is not part of a “Group” which has been 
assigned to operate as an “Audible” under the group operations tab. 
 
In the example below Group 8 is being used as an audible group. 
 
Group Tab 
 
This screen shot indicates that a channel has been set to Group 8. 
 

 
 
Group Operations Tab 
 
This screen shot indicates that Group “Type” for Group 8 has been set to 
operate as “Audible”. 
 

 
 
 
To prevent the audible sounding the user should select the associated alarm 
LED on the software faceplate and uncheck the tick box associated with any 
Group being used as an Audible in the example above this would be Group 8.  
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ISA A-5 – Automatic Reset – No Flash 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL
OR NORMAL

ALARM
ON

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE
WHILE ABNORMAL

RETURN
 TO NORMAL

 TO 
ABNORMAL

ACKNOWLWDGE
WHILE NORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL
OR NORMAL

SILENT

ON
ACKNOW

 
Sequence Features 
 

1. Acknowledge and test pushbuttons. 
2. Alarm audible device 
3. The visual alarm does not flash 
4. Lock In of momentary alarms until acknowledged 
5. The Audible device is silenced when acknowledged. 
6. Automatic reset of acknowledged alarms when the process has 

returned to normal 
7. Operational test 
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ISA M – Manual Reset – Lock In 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL
OR NORMAL

ALARM
FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE
WHILE ABNORMAL

RESET
 WHILE NORMAL

 TO 
ABNORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL
OR NORMAL

SILENT

ON
ACKNOW.

 
Sequence Features 
 

1. Acknowledge, reset and test pushbuttons. 
2. Alarm audible device 
3. Lock In of momentary alarms until acknowledged 
4. The Audible device is silenced and the flashing visual alarm stops 

when acknowledged. 
5. Manual reset of acknowledged alarms when the process has returned 

to normal 
6. Operational test 
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ISA M-1-2 – Manual Reset – Silence Pushbutton Interlock 
 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 
OR NORMAL

ALARM
FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

SILENCE

RESET
WHILE NORMAL

 TO 
ABNORMAL

ACKNOWLEDGE

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL 
OR NORMAL

SILENT

FLASHING
SILENCE

ABNORMAL 
OR NORMAL

PROCESS

VISUAL

AUDIBLE

SEQUENCE

ON

SILENT

ACKNOW

 
Sequence Features 
 

1. Acknowledge, reset and test pushbuttons. 
2. Alarm audible device 
3. Lock In of momentary alarms until acknowledged 
4. Silence pushbutton must be pressed before acknowledge 
5. Silence stops the audible alarm only 
6. The flashing stops when acknowledged.  
7. Manual reset of acknowledged alarms when the process has returned 

to normal 
8. Operational test 
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ISA R – Ringback 
 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 
OR NORMAL

ALARM
FAST FLASH

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS ABNORMAL 

SILENT

ON
ACKNOW

NORMALPROCESS

VISUAL

SEQUENCE

SLOW FLASH
RINGBACK

TO ABNORMALRESET

RETURN 
TO NORMAL

RETURN TO ABNORMAL

ACK WHILE NORMAL

ACKNOW
WHILE ABNORMAL

RINGBACK
AUDIBLE PULSING

 
 
 
Sequence Features 
 

1. Acknowledge, reset and test pushbuttons. 
2. Alarm audible device. (optional Ringback audible device) 
3. Lock In of momentary alarms until acknowledged 
4. The audible device is silenced and the flashing stops when 

acknowledged 
5. Ringback visual ad audible indications when the process condition 

returns to normal 
6. Manual reset of Ringback indications 
7. Operational test  
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ISA F1A-1 – Automatic Reset First Up 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL
OR NORMAL

FIRST ALARM
FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE
WHILE ABNORMAL

(FIRST OUT RESET)

RETURN
 TO NORMAL

FIRST TO 
ABNORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS ABNORMAL

SILENT

ON
ACKNOW.

SUBSEQUENT 
 TO ABNORMAL

 
Sequence Features 
 

1. Acknowledge and test pushbuttons. 
2. Alarm audible device 
3. Lock In of momentary first alarm only, no lock in of momentary 

subsequent alarms  
4. Flashing and audible indications for first alarm only, new subsequent 

alarms go to the acknowledge state. 
5. First out indication is reset and the audible is silenced when 

acknowledged. 
6. Automatic Reset of acknowledged alarm indications when the process 

returns to normal 
7. Silence pushbutton can be used to silence the audible alarm only 
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ISA F2M-1 – Manual Reset First Up 
 

 

PROCESS

AUDIBLE

VISUAL

SEQUENCE

ACKNOWLEDGE
VISUAL ON

FIRST ALARM

SEQUENCE ISA   F2M-1
(MANUAL RESET FIRST OUT WITH NO SUBSEQUENT ALARM FLASHING & SILENCED PUSHBUTTON)

AUDIBLE

ACKNOWLEDGE
(FIRST OUT RESET)

VISUAL

SEQEUNCE

PROCESS

SILENT

FLASHING

FIRST SILENCED SILENCE

ACKNOWLEDGE
(FIRST OUT RESET)

SILENT

ACKNOWLEDGED

ON

AUDIBLE

AUDIBLE

VISUAL

SEQUENCE

ON

PROCESS

AUDIBLE

FLASHING

ABNORMAL

SILENCE

PROCESS

SEQUENCE

RESET WHILE
NORMAL

AUDIBLE

VISUAL

PROCESS

SEQUENCE

SUBSEQUENT TO 
ABNORMAL

SUBSEQUENT
ALARM

SILENT

OFF

NORMAL

NORMAL

FIRST TO 
ABNORMAL

SEQUENCE DIAGRAM

OR NORMAL

ABNORMAL

OR NORMAL

ABNORMAL

OR NORMAL

ABNORMAL

OR NORMAL
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LINE 
PROCESS 

CONDITION 
PUSHBUTTON 
OPERATION 

SEQUENCE 
STATE 

VISUAL 
DISPLAY 

ALARM 
AUDIBLE 
DEVICE 

REMARKS 

1 NORMAL  NORMAL OFF SILENT  
2 FIRST ABNORMAL  FIRST ALARM FLASHING AUDIBLE LOCK-IN 
3 SUB. ABNORMAL  SUB. ALARM ON AUDIBLE LOCK-IN 

4 FIRST 
ABNORMAL OR 

NORMAL ACKNOWLEDGE 
BEFORE SIL 

TO LINE 7 

FIRST OUT 
RESET 

5 SUB. 
ABNORMAL OR 

NORMAL 
 

6 FIRST 
ABNORMAL OR 

NORMAL 
SILENCE FIRST SILENCED FLASHING SILENT  

7 SUB. 
ABNORMAL OR 

NORMAL 
SILENCE ACKNOWLEDGE ON SILENT 

MANUAL 
RESET 

REQUIRED 

8 FIRST 
ABNORMAL OR 

NORMAL 
ACKNOWLEDGE 
AFTER SILENCE 

TO LINE 7 
FIRST OUT 

RESET 

9 NORMAL RESET NORMAL OFF SILENT 
MANUAL 
RESET 

 
 
SEQUENCE FEATURES 
 

1. Silence, acknowledge, reset and test pushbuttons 
2. Alarm audible device 
3. Lock-in of momentary alarms until acknowledged.  
4. Option1 – silence pushbutton to silence the alarm audible 

device while retaining the first out flashing indication 
5. Flashing indication for first alarm only. new subsequent 

alarms have the same visual indication as acknowledged 
alarms. 

6. First out indication is reset when acknowledged 
7. Manual reset of acknowledged alarm indications after 

process conditions return to normal. 
8. Operational test 

 

ISA F2A-1 – Automatic Reset First Up 
This sequence is the same as ISA F2M-1 with the exception that the alarms 
are automatically reset once the process has returned to normal. 
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ISA F3A – Automatic Reset First Up 

 
 

 
 
 
 
 
 
 
 
 

AUDIBLE

PROCESS

VISUAL

SEQUENCE

SEQUENCE ISA   F3A
(AUTOMATIC RESET FIRST OUT WITHOUT FLASHING & RESET PUSHBUTTON)

FIRST OUT RESET
WHILE ABNORMAL

AUDIBLE

VISUAL

SEQUENCE

SILENT

PROCESS

ACKNOWLEDGE

SILENT

FIRST 

SLOW FLASHING

ABNORMAL

AUDIBLE AUDIBLE

INTERMITTENT
FLASHING

FIRST ALARM

FIRST OUT RESET

SUBSEQUENT
ACKNOWLEDGE

ON

ABNORMAL

VISUAL

AUDIBLE

PROCESS

STATE

SEQUENCE

VISUAL

PROCESS

FAST FLASHING

ON

SUBSEQUENT
ALARM

ABNORMAL

SEQUENCE DIAGRAM

RETURN 
TO NORMAL

ACKNOWLEDGE 
WHILE NORMAL

AUDIBLE

VISUAL

PROCESS

SEQUENCE FIRST TO 
ABNORMAL

SUBSEQUENT TO 
ABNORMAL

SILENT

OFF

NORMAL

NORMAL

ABNORMAL 

ACKOWLEDGED

OR NORMAL
FIRST OUT RESET
WHILE NORMAL

A
C

K
N

O
W

L
E

D
G

E
 

W
H

IL
E

 A
B

N
O

R
M

A
L

OR NORMAL

OR NORMAL
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SEQUENCE TABLE 

 

LINE 
PROCESS 

CONDITION 
PUSHBUTTON 
OPERATION 

SEQUENCE 
STATE 

VISUAL 
DISPLAY 

ALARM 
AUDIBLE 
DEVICE 

REMARKS 

1 NORMAL  NORMAL OFF SILENT  

2 FIRST ABNORMAL  FIRST ALARM 
INTERMITTENT 

FLASHING 
AUDIBLE LOCK-IN 

3 SUB. ABNORMAL  SUB. ALARM 
FAST 

FLASHING 
AUDIBLE LOCK-IN 

4 FIRST 
ABNORMAL 
OR NORMAL 

FIRST OUT 
RESET BEFORE 
ACKNOWLEDGE 

TO LINE 3 
FIRST OUT 

RESET 

5 FIRST 
ABNORMAL 
OR NORMAL 

ACKNOWLEDGE 

FIRST 
ACKNOWLEDGED 

SLOW 
FLASHING 

SILENT 
FIRST OUT 

RESET 
REQUIRED 

6A SUB. ABNORMAL  
SUB. 

ACKNOWLEDGE 
ON SILENT 

MAINTAINED 
ALARM 

6B SUB. NORMAL TO LINE 8 
MOMENTARY 

ALARM 

7A FIRST ABNORMAL FIRST OUT 
RESET AFTER 

ACKNOWLEDGE 

TO LINE 6A 
FIRST OUT 

RESET 

7B FIRST NORMAL TO LINE 8 
FIRST OUT 

RESET 

8 NORMAL  NORMAL OFF SILENT 
AUTOMATIC 

RESET 
 
 

SEQUENCE FEATURES 
 
1. Silence, acknowledge, reset and test pushbuttons 
2. Alarm audible device 
3. Lock-in of momentary alarms until acknowledged.  
4. Flashing indication for first alarm only. New subsequent alarms 

have the same visual indication as acknowledged alarms. 
5. First out indication is reset when acknowledged 
6. Manual reset of acknowledged alarm indications after process 

conditions return to normal. 
7. Operational test 

ISA F3A-3 – First Out Reset Interlock 

 
This sequence is the same as F3A with the addition of First Reset Interlock 
which requires acknowledge to be pressed before First Reset will function. 
 

ISA F3M – Manual Reset First Out  

 
This sequence is the same as F3A with the addition of Manual Reset. All 
alarms must be manually reset once the process has returned to normal.  
 

ISA F3M-1-2 – Manual Reset First Out with Silence Interlock 
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This sequence is the same as F3A with the addition of Silence Interlock and 
Manual Reset.  
 
The Silence pushbutton must be operated before alarms can be 
acknowledged. The Silence pushbutton stops the Audible alarm only. 
 
All alarms must be manually reset once the process has returned to normal.  
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19  COMMUNICATIONS  
 
Port 1 

Connection Details 

 
A standard RJ45 8P8C socket is provided on the rear of the SmartAlarm for 
systems equipped with the Modbus RTU option which provides the following 
connections:- 
 

 
 

Port 1 Connection Details – Smart Alarm 
 
 

1. No Connection 
2. No Connection 
3. GND 
4. RxB 
5. RxA 
6. GND 
7. TxA 
8. TxB 
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MODBUS RTU 

 
The tables below show the standard message formats for data interchange for 
Modbus RTU protocol. 
 
 
RTU tables. Each character represents 8 bit binary data in 

hexadecimal format. 
Y represents a character with more than one possible 
value. 
All characters are framed with 1 start bit, 1 parity bit and 1 
stop bit. 

 
 
Read Request – Master 
 
 

RTU 

START ADDRESS FUNCTION 
REGISTER / 

COIL 
ADDRESS 

NO. OF 
REGISTERS / 

COILS  

ERROR 
CHECK 

STOP 

ELAPSED TIME 3 
½  

CHARACTERS 
MIN 

Y Y YY YY YY 

ELAPSED TIME 
3 ½  

CHARACTERS 
MIN 

 
 
Read Response - Slave 
 
 

RTU 

START ADDRESS FUNCTION 
BYTE 

COUNT 
DATA 

ERROR 
CHECK 

STOP 

ELAPSED 
TIME 3 ½  

CHARACTERS 
MIN 

Y Y Y YY YY 

ELAPSED 
TIME 3 ½  

CHARACTERS 
MIN 

 
 
Single Write Request/Response 
Master write request and slave write response, are the same. 
 
 

RTU 

START ADDRESS FUNCTION 
REGISTER / 

COIL 
ADDRESS 

DATA 
ERROR 
CHECK 

STOP 

ELAPSED 
TIME 3 ½  

CHARACTERS 
MIN 

Y Y YY YY YY 

ELAPSED 
TIME 3 ½  

CHARACTERS 
MIN 

 
 
 
 
 
 
 
 
 
Multiple Write Request 
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RTU 

START ADDRESS FUNCTION 
REGISTER / 

COIL 
ADDRESS 

QTY BYTE 
COUNT DATA 

ERROR 
CHECK 

STOP 

ELAPSED 
TIME 3 ½  
CHARS 

MIN 

Y Y YY YY Y YY YY ELAPSED 
TIME 3 ½  

CHARS MIN 

 

 
Multiple Write Response 
 
 

RTU 

START ADDRESS FUNCTION 
REGISTER / 

COIL 
ADDRESS 

QTY 
ERROR 
CHECK 

STOP 

ELAPSED 
TIME 3 ½  
CHARS 

MIN 

Y Y YY YY YY ELAPSED 
TIME 3 ½  

CHARS MIN 

 
 

Address 
Each alarm card is addressed directly. On a typical 24Way SmartAlarm, first 
alarm card data is accessed using node address 1, second alarm card using 
node address 2 etc. As default the first node address starts at 1, this can be 
modified using the configuration software. Select View - Advanced then 
Comms tab and adjust the field marked “Comms Address Offset”. 
 
First card Node Address   = 1 + Comms Address Offset. 
Second card Node Address  = 2 + Comms Address Offset. 
Third card Node Address   = 3 + Comms Address Offset. 
 
Comms Address Offset default is 0. 
 
Function  
Modbus Function No. 
 
Error Check 
This defines the error checking format required, for Modbus RTU this should 
be set to CRC (Cyclic Redundancy Check) 
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Modbus Slave – Standard Communications 

 
Function Descriptions 
This section describes the process of reading from and writing data to a 
SmartAlarm annunciator. 
 
 

Read Coil Status – Function 01 – Read Request – Master 

 
Coil Address 
This is used to address the “start” channel to be read, typically the first 
channel “channel 1” contact status on alarm card would be coil address 00 01 
 
To read the contact status coils use address range 1- 8 
To read the alarm status coils use address range 11- 18 
To read the disable status coils use address range 21- 28 
 
Number of Coils 
This represents the number of coils (Channels) the master wishes to read. 
The range is 1- 8. 
 

Read Coil Status – Function 01 – Read Response - Slave 

 
Byte Count 
This represents the number of data bytes sent  
 
Data 
Data returned depends on coil address originally specified by the master. 
 
Coil address 1 - 8 returns Contact status data 
0 = Contact Normal 
1 = Contact Abnormal 
 
Coil address 11 - 18 returns Alarm status data 
0 = Alarm Normal 
1 = Alarm Abnormal 
 
Coil address 21 - 28 returns Disable status data  
0 = Channel Enabled 
1 = Channel Disabled 
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Typical Example of Message Format  
To read all contact status data on a 24 way SmartAlarm the following 
message format has to be repeated 3 times, once for each alarm card node 
address.  
 
RTU 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

ERROR 
CHECK 

01 01 00 01 00 08 6C 0C 

 
Example shows message for first card, Comms address offset 0.  
 
 

Read Status – Function 03 – Read Request – Master 

 
Register Address 
This is used to address the “start” channel to be read, typically the first 
channel “channel 1” contact status on alarm card would be register address 
40001 
 
To read the contact status registers use address range 40001- 40008 
To read the alarm status registers use address range 40011- 40018 
To read the disable status registers use address range 40021- 40028 
 
Number of Registers 
This represents the number of registers (Channels) the master wishes to 
read. The range is 1- 8. 
 

Read Status – Function 03 –  Read Response - Slave 

 
Byte Count 
This represents the number of bytes sent  
 
Data 
Data returned depends on register address originally specified by the master. 
 
Register address 40001 - 40008 returns Contact status data 
0 = Normal 
1 = Abnormal 
 
Register address 40011 - 40018 returns Alarm status data 

64 Alarm Event return to normal 
65 Subsequent Alarm Event activated 
66 First-up Alarm Event activated 
67 Subsequent Alarm Event Acknowledged 
68 First-up Alarm Event Acknowledged 
69 Alarm Event Ring-back 
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Register address 40021 - 40028 returns Disable status data 

2 Channel Shelved 
3 Channel Disabled 
4 Channel Unshelved 
5 Channel Enabled 
7 Channel Inhibited 
8 Channel Uninhibited 

 
 
 
Typical Example of Message Format  
To read all contact status data on a 24 way SmartAlarm the following  
message format has to be repeated 3 times, once for each alarm card node 
address. 
 
RTU 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

ERROR 
CHECK 

01 03 9C 41 00 08 3A 48 

 
Example shows message for first card, Comms address offset 0.  
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Write Multiple Coils – Function 15 - Read Request – Master 

 
Coil Address 
Indicates first coil address to be written. Typically the first channel contact 
status on an alarm card “channel 1” would be coil address 00 01. 
 
To write the contact status coils use address range 1- 8. 
 
Note: To initiate input status change via message 15 “Input via serial comms” 
must be selected for each channel. Selection is via the configuration software. 
 
Quantity 
This represents the number of coils (Channels) the master wishes to write 
 
Byte Count 
This represents the number of data bytes sent  
 
Data 
This represents the status of the coil to be written 
0 = Contact Normal 
1 = Contact Abnormal 
 

Write Multiple Coils – Function 15 – Read Response - Slave 

 
Coil Address 
Indicates first coil address to be written. Typically the first channel contact 
status on an alarm card “channel 1” would be coil address 00 01. 
 
Quantity 
This represents the number of coils the master has written 
 
Typical Example of Message Format  
To write alternate contacts abnormal on a 24 way SmartAlarm where each 
alarm card is treated as an individual node. The following message format 
would have to be repeated 3 x times, once for each card node address. 
 
RTU 

ADDRESS FUNCTION 
REGISTER
ADDRESS 

No Of 
REGISTERS 

BYTE 
COUNT 

DATA 
ERROR 
CHECK 

01 0F 00 01 00 08 01 AA 43 2A 

 
Example shows message for first card, Comms address offset 0.  
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20  SPECIFICATIONS 
 

Primary power supply  
 

 Universal Input Type capable of accepting 85 – 264VAC 50/60Hz or  
88 to 300VDC 
 

Optional version (Must be specified at time of order) 
 

 19 to 72VDC.  

Aux power supplies  
 

 Universal Input Type capable of accepting 85 – 264VAC  50/60 Hz  or 
88 to 300VDC. 
 

Optional version (Must be specified at time of order). 
 

 19 to 72VDC.  
 

CAUTION
 

Power supplies must be fused externally with a 1AT fuse or suitable MCB. 

 
 
 
 

Maximum Power 
The maximum power rating for the range of SmartAlarm unit 8 through to 24 
channel is 8 Watts Maximum 

Signal Inputs 

 All inputs are provided with optical isolators capable of withstanding a 
1000 volts megger test to ground. 
 

 The standard unit provides an isolated +24VDC as a signal supply 
voltage and options exist for 24VDC, 48V DC, 125V AC/DC or 250V 
AC/DC. 

Input response time 

 The user can select the response time required per channel in the 
range 1ms to 65S using the Eaton supplied configuration software. 

First-Up discrimination 

 Better than 10mS.  
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Outputs 

Individual channel repeat relays 
As an option each channel within the Annunciator can be supplied with a 
dedicated low power magnetically latched pulse relay with a configurable N/O 
or N/C contact for use with 3rd Party devices. 
 
Contact rating  
 
Voltage Rating (resistive) 
24VDC 0.2A 
110VDC 0.2A 

HNA & HNB Horn Relays 
Two horn relays are provided as standard HNA & HNB each providing a N/O 
contact for use with external horns or 3rd party devices. 
 
Contact rating  
 
Voltage Rating (resistive) 
30VDC 2A 
125VAC 2A 
115VDC 150mA 

GPA & GPB Common Alarm Group Relays 
Two common alarm group relays are provided as standard GPA & GPB each 
providing a configurable N/O or N/C contact for use with 3rd party devices. 
 
Contact rating  
 
Voltage Rating (resistive) 
24VDC 1A 
110VDC 0.2A 
 
Watchdog Relay 
A single contact that can mapped to many functions via the software 
configurator, such as “All Faults”, Pushbutton repeats, Comms Fault Etc. 
 
Voltage Rating (resistive) 
24VDC 1A 
110VDC 0.2A 
 

Audible alarms 
An integrally mounted 2.4Khz piezoelectric horn is provided as standard. 
Rated at 85db @ 30cm. 

Communications 
SmartAlarms can be provided with an isolated RS485 Comm’s Port using 
Modbus RTU Protocol. 
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Environmental Specifications 

Temperature 
Operating Temperature - 20 to + 60 Degrees C 
Storage Temperature    - 20 to + 80 Degrees C 
Humidity 0 – 95% RH, Non Condensing 

Protection 
Annunciator front: IP40 
Annunciator rear: IP20 
Optional front  IP54  

EMC Compliance  

IEC61326-1: 2013 

Radiated RFI Immunity 
 IEC 61000-4-3 

Conducted RFI Immunity 
 IEC 61000-4-6 

Radiated Emissions 
 IEC 61000-6-3 

Conducted Emissions 
 IEC 61000-6-3 

Radiated Power Frequency Magnetic Field 
 IEC 61000-4-8 

ESD Effects  
 IEC 61000-4-2 

Surge Withstand – Oscillatory 
 ANSI C37.90.1 

Electrical Fast Transient/Burst Immunity 
 IEC 61000-4-4 

Surge Immunity 
 IEC 61000-4-5 

LVD 

 EN 61010-1-2010 
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21 SPARE PARTS LIST 

Alarm Card Spares 
 

Product Code Description 

P825-SPR-001 SmartAlarm Installation Spares Kit 

P825-SPR-002 
SmartAlarm Active Alarm card Spares 
MLPCBP82521-3    P825 ALM 24/125V PCB ASSY       

P825-SPR-003 
SmartAlarm Active Alarm card Spares 
MLPCBP82521-33   P825 ALM 24/125V PCB ASSY - 
CC         

P825-SPR-004 
SmartAlarm Active Alarm card Spares 
MLPCBP82522-3    P825 ALM 24/125V RLY2 PCB 
ASSY         

P825-SPR-005 
SmartAlarm Active Alarm card Spares 
MLPCBP82522-33   P825 ALM 24/125V RLY2 PCB 
ASSY - CC    

P825-SPR-006 
SmartAlarm Active Alarm card Spares 
MLPCBP82523-3    P825 ALM 48/250V PCB ASSY       

P825-SPR-007 
SmartAlarm Active Alarm card Spares 
MLPCBP82523-33   P825 ALM 48/250V PCB ASSY - 
CC         

P825-SPR-008 
SmartAlarm Active Alarm card Spares 
MLPCBP82524-3    P825 ALM 48/250V RLY2 PCB 
ASSY         

P825-SPR-009 
SmartAlarm Active Alarm card Spares 
MLPCBP82524-33   P825 ALM 48/250V RLY2 PCB 
ASSY - CC    

P825-SPR-010 
SmartAlarm Active Alarm card Spares 
MLPCBP82525-3    P825 ALM 24/125V RLY1 PCB 
ASSY         

P825-SPR-011 
SmartAlarm Active Alarm card Spares 
MLPCBP82526-3    P825 ALM 48/250V RLY1 PCB 
ASSY         

 

Common Card Spares 
 

Product Code Description 

P825-SPR-012 
SmartAlarm Common Services card Spares 
MLPCBP82531-3    P825 COMMON SERVICES PCB 
ASSY          

P825-SPR-013 
SmartAlarm Common Services card Spares 
MLPCBP82531-33   P825 COMMON SERVICES PCB 
ASSY - CC     
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Power Supply Spares 
 
 

Product Code Description 

P825-SPR-014 
SmartAlarm Power Supply card Spares           
MLPCBP82541-3    P825 P1-AC P2-AC PCB ASSY       

P825-SPR-015 
SmartAlarm Power Supply card Spares           
MLPCBP82541-33   P825 P1-AC P2-AC PCB ASSY - 
CC         

P825-SPR-016 
SmartAlarm Power Supply card Spares           
MLPCBP82547-3    P825 P1-AC P2-NONE PCB 
ASSY            

P825-SPR-017 
SmartAlarm Power Supply card Spares           
MLPCBP82547-33   P825 P1-AC P2-NONE PCB 
ASSY - CC       

P825-SPR-018 
SmartAlarm Power Supply card Spares           
MLPCBP82550-3    P825 P1-36V P2-NONE PCB 
ASSY           

P825-SPR-019 
SmartAlarm Power Supply card Spares           
MLPCBP82550-33   P825 P1-36V P2-NONE PCB 
ASSY - CC      

P825-SPR-020 
SmartAlarm Power Supply card Spares           
MLPCBP82551-3    P825 P1-AC P2-36V PCB ASSY      

P825-SPR-021 
SmartAlarm Power Supply card Spares           
MLPCBP82551-33   P825 P1-AC P2-36V PCB ASSY - 
CC        

P825-SPR-022 
SmartAlarm Power Supply card Spares           
MLPCBP82552-3    P825 P1-36V P2-36V PCB ASSY    

P825-SPR-023 
SmartAlarm Power Supply card Spares           
MLPCBP82552-33   P825 P1-36V P2-36V PCB ASSY 
- CC       

LED Spares 
 
 

Product Code Description 
P825-SPR-024 P825LED-SMT-BL    SmartAlarm P825 BLUE LED 
P825-SPR-025 P825LED-SMT-GN   SmartAlarm P825 GREEN LED 
P825-SPR-026 P825LED-SMT-RD    SmartAlarm P825 RED LED 
P825-SPR-027 P825LED-SMT-WT   SmartAlarm P825 WHITE LED 
P825-SPR-028 P825LED-SMT-YW   SmartAlarm P825 YELLOW LED 
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22  SERVICING 

Module Removal 
 
All of the cards within the SmartAlarm are removable from the front of the 
instrument 
 
To remove a card we recommend the following procedure:- 
 

1. Isolate the power to the Annunciator. 
 

2. Undo the retaining screws on the face of the annunciator and remove 
the face plate. 
 

3. Remove the Alarm or Common Services card as required. 
 

4. Alarm cards and Common Services cards are keyed to prevent 
accidental insertion into the incorrect slot.  
 
 
IMPORTANT 

 
Although alarm cards are universal in type, if a card has been replaced 
the user will need to download the original software configuration to 
the unit to ensure that the features of the new card match the original 
one. 
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23  CONTACT 
Eaton Electric Limited 
Great Marlings 
Butterfield 
Luton 
Bedfordshire 
LU2 8DL 
 
Telephone / Fax Number List 
 
Telephone: 0044 (0) 1582 723633 
           Fax: 0044 (0) 1582 422283 
 
Email address: RTKEnquiry@Eaton.com  
 

Procedures for Factory Repair and Return Warranty. 
 
All products are tracked through a quality maintenance system located at our 
Luton based manufacturing site. Any warranty or repairs are managed  by 
supplying the customer with a unique QN number that tracked any return 
through the system. 
 
For assistance with any warranty claim or repair, please contact our repair 
team s on the above number who will then guide you through the process 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


